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Getting Started with Reyburn CyberTuner for Pocket PC  (v4.6x) 1
Congratulations on your decision to use Pocket Reyburn CyberTuner!

This Getting Started Manual will teach you almost everything you need to know about tuning
pianos with Pocket RCT.

To learn more:

Watch the Pocket RCT video included with purchase. It takes only 10 minutes to see Pocket
RCT used to tune a piano, and in another 10 minutes you will see a Pitch Raise demonstrated.
The video is available in DVD format. DVD-R format will play in most newer DVD players and
Windows or Macintosh computers equipped with a DVD drive.

Pocket RCT is very similar to RCT for laptops, so you can read the 138 page RCT User Manual
available as a PDF download at our website, www.reyburn.com/download. PDF files can be read
on a laptop/desktop computer.

This Getting Started Manual and other documentation are provided as electronic PDF files

on your SentinelKey memory card. To load PDF files from your Pocket RCT SentinelKey to a
computer, use the SD to USB memory card reader for your computer which came with Pocket
RCT. Pocket RCT PDF documents can also be downloaded at www.reyburn.com/download.html.

Pocket RCT upgrades are for free for at least one year from original purchase. Upgrades will
contain additional capabilities such as the ability to run on newer versions of Windows Mobile,
and/or our latest advances in tuning technology. To receive notices of upgrade releases by email
subscribe to CTuner or RCTUpgrade (described below).

Subscribing to one of our email lists is the only way to receive upgrade notices, special
introductory pricing on RCT upgrades and other special offers. We don't send offers through the
postal service.

Do this first

Read your Pocket PC device’s manual! Most Pocket PCs come with a short and well-written
manual. Some devices require charging for several hours before starting the device for the first
time. Consult your device’s manual for essential skills such as soft reset, hard reset, character
input, and button operation. These operations may vary between manufacturers and are not
specific to Pocket RCT. Before contacting RCT support, please try soft reseting your device!

Do you know how to soft reset your device? If not please take the time to learn this simple skill
from your hardware manual. Soft resetting will solve spinner and other issues with your machine.

Preparing for Pocket RCT: Turn off all programs and processes such as bluetooth, WiFi or GPS.
Installing Pocket RCT

Included with your purchase of Pocket RCT is a SentinelKey memory card. Depending on
your device's capabilities, your Sentinelkey will be either a Compact Flash (CF) or Secure Digital
(SD) card or micro-SD card. Your SentinelKey has two important items:

1. Pocket RCT Installer, containing the current version of Pocket RCT at time of purchase.
2. Your Pocket RCT serial number written in red ink on the SentinelKey's label.

A laptop/desktop computer is NOT needed during Pocket RCT installation.



2 Installing Pocket RCT (continued)

The first time you install Pocket RCT, you will use the Pocket RCT SentinelKey memory card (described
below). A generic SD memory card may be used for installing subsequent updates; if so, you may be
prompted to insert your SentinelKey after installation and before activation, as described later.

Make sure you stay updated to the latest Pocket RCT version. Older versions of Pocket RCT may not
run on newer Pocket PC operating systems or models. To assure compatibility always install the latest
version first on a new machine. See page 19 for how to obtain the latest version.

Step-by-step instructions for installing or updating Pocket RCT
1. Turn on your Windows Mobile Pocket PC device.

Note: If you are not sure where the power button or memory card slot is located on your device, please
refer to your hardware documentation.

If you purchased a Pocket RCT/Hardware Package, Pocket RCT should already be installed, activated
and calibrated. In that case, skip to the next page "Send in your registration card".

2. If you have a copy of the RCT Ten Styles Library on memory card, AND this is a first time install for
this machine, (or your RCT Ten Styles Library is missing), insert and install that card now. (A version of
Pocket RCT may also be installed from the library card).

3. If you have a Pocket RCT update memory card, insert the card with the most recent version and
install. Pocket RCT will tell you to insert your SentinelKey. (If you don't have a Pocket RCT update card,
skip to the next step).

4. Insert RCT SentinelKey into the slot with the RCT logo facing front into the slot.

Note on installing: A few seconds after inserting the memory card the Installer should start
automatically (whether it's a Ten Styles Library card, generic update card or SentinelKey). If not see the
troubleshooting section on page 19 for manual install instructions. Hint: Many problems can be solved if
you do a soft reset and try again. Try soft reset before manual install.

Windows Mobile 5 and later may ask you to install on Device or SD Card. Always install to the Device,
never to SD card.

5. Installation takes about 15 to 20 seconds. If you're updating, you may be told that Pocket RCT is
already installed, Re-install? Tap the OK button. Hint: You can update Pocket RCT to a newer version
without first removing the older version.

6. Pocket RCT should start automatically. If not, tap the Start menu and tap the Pocket RCT icon. If
there is no Pocket RCT icon in the Start menu tap Start Menu > Settings > Menus and select Pocket
RCT. Uncheck another item if needed.

7. If you're installing Pocket RCT for the first time (or are installing a major upgrade), an Activation Code
dialog box will appear. Every Activation Code is unique to a Pocket PC and its Pocket RCT SentinelKey.
Enter your Activation Code exactly as written on the SentinelKey's packaging or in the email sent

to you. Tap in the next entry box to advance every six characters. When you’re done entering the
Activation Code, check it again and tap the Activate button.

If you don’t have an Activation Code, please read the red sheet "Where's My Activation Code?" included
with purchase, also printed at the end of this manual.

Immediately after activation is successfully completed, remove the Pocket RCT SentinelKey card and
store it in a safe place in its original packaging.
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MORE IMPORTANT: Do not lose your Pocket RCT SentinelKey memory card! This special
memory card is required for initial installation and later upgrades. If you lose your Pocket RCT
SentinelKey card you may have to repurchase Pocket RCT at full price.

Moving Pocket RCT to another Pocket PC device - Pocket RCT License

At a later date, you may decide to move Pocket RCT to another device. Please remember that the
Pocket RCT license allows you to run Pocket RCT on only one machine at a time.

CAUTION: BEFORE deactivating Pocket RCT, please check the reyburn.com web site as there may
be a charge for support! See the pRCT support page at www.reyburn.com/prctsupport for details.

To move your license to another machine, you must first obtain a second compatible device and install
the latest Pocket RCT version. If install is successful (viewing PRCT activation window means success)
then deactivate Pocket RCT from the original device, and request a new Activation Code for the second
device.

To deactivate Pocket RCT, go to Start menu > Settings > System tab > Remove Programs then
select "Reyburn Piano Service, Inc. Pocket RCT" and tap Remove. After removal and deactivation is
complete, you'll see an 8 digit Deactivation Code. Carefully write it down and save it. You must submit
this Deactivation Code with your request for a new Activation Code.

If you can't remove and deactivate Pocket RCT from your old machine, please be prepared to provide

proof positive of what happened to the old machine, a police report if it was stolen, documentation that
it was replaced under warranty, sending us the old machine etc.... Don't dispose of an old Pocket PC

(even if broken) before contacting us to be assured we can provide you with a new activation code for
the new machine.

Calibrate your Pocket PC

To be sure your tunings will be perfectly on pitch, calibrate your Pocket PC device immediately after
installation and activation. To calibrate see page 22 of this manual “Calibrating the pitch of your Pocket
PC”, or the blue sheet included with Pocket RCT purchase. @

Send in your registration card

To become a registered owner of Pocket RCT and be eligible for support, fill out and mail in your
Pocket RCT registration card. If you did not purchase your copy of Pocket RCT from an authorized
RCT distributor, you still may be able to register Pocket RCT for a fee, see www.reyburn.com/
supportpackage

Join CTuner or RCTUpgrade 'ﬁ

Registered owners of Pocket RCT and RCT (Mac and Windows) are eligible to join CTuner and
RCTUpgrade. CTuner is a free email discussion group about Pocket RCT and RCT and where we post
announcements of upgrade releases.. RCTUpgade is for users who want to receive only notices of
upgrade releases without any discussion. As a CTuner subscriber, any email you send to the CTuner
list will automatically be sent to all other CTuner subscribers. Likewise, email from other CTuner
subscribers will automatically be sent to you. To subscribe to CTuner or RCTUpgrade, see <www.
reyburn.com/lists.html>.

Make friends with Pocket RCT on-line Help

Pocket RCT on-line Help will provide quick answers to many of your questions. To use Pocket RCT
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Help on your Pocket PC (Pocket RCT must be running) tap Start menu > Help.
Return to Pocket RCT by tapping OK (located upper right of the Help window) or
tapping Start > Pocket RCT.

Pocket RCT Support

Email support is available through our Support Request Form at www.reyburn.
com/support.html. If you have “emergency” questions about Pocket RCT, you may
phone us (see contact page at end of this manual). Have your device in hand and
be prepared to provide us with your Pocket RCT version number and serial number
(in Pocket RCT, tap About menu), Pocket PC model, your full name, and a detailed
description of your problem. It may help if a piano or your CyberFork are nearby.

For questions about your Pocket PC device, synchronization programs such
as ActiveSync, or non-Pocket RCT software or hardware, please contact the
appropriate vendor or manufacturer.

Tuning a piano with Pocket RCT
The two modules used for tuning pianos are Chameleon 3 and CyberEar.

Chameleon 3 measures and records five (or six) sample notes, then calculates a
tuning record with the correct pitches for all 88 notes.

CyberEar helps you tune each string to its correct pitch with a rotating Spinner as a
visual aid.

Creating a tuning in Chameleon 3
To create a new tuning

Turn on your Pocket PC. Tap the Start menu and select Pocket RCT. Set your device
on or near the piano. We strongly recommend you purchase a special Pocket PC
device holder (see back page for contact info). It's designed specifically for piano
tuners and can be used on verticals and grands.

Pocket RCT automatically opens to Chameleon 3 (Ch3). The first time you use
Pocket RCT, Ch3 will be set to Easy mode so the following explanations describe
Easy mode. Easy mode automatically chooses settings that works best on most
pianos and is recommended for new users of Pocket RCT, especially tuners with
less experience. Advanced mode, the other Ch3 choice, allows you to customize
your tunings (e.g., wider or narrower stretches, various listening partials, etc.).
Advanced Mode is described later in this manual.

Mute the unison of A4 (A above middle C) so only one string is sounding. Tap the
Record button (with the red dot) to begin sampling. A finger will point to the note you
should play. Play the note with a consistent medium strength (mf) blow. Hold down
the note while the rings pulse around the ear (indicating Ch3 is listening) and release
the note when the tuning fork spins (indicating Ch3 is calculating and storing).

After playing A4 three times, the actual pitch of A4 will be displayed in Hertz (e.g.
440.10) or cents from 440 (e.g. +0.38¢). To switch between hertz and cents, tap on
A4’s pitch reading. This feature helps you decide whether the piano needs a Fine
Tuning or a Pitch Raise. Generally, if the piano is off by more than .25 Hertz or 1¢,
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Smart Tune or Pitch Raise mode is recommended. (Much more on changing
pitch below.) After sampling A4, you’ll sample A3, A2, A1, and A5 (A6 if needed,
Advanced Mode only).

Chameleon 3 displays the pitch of each note A1 to A5 as it is recorded. The pitch
offset in cents is relative to the tuning which would be calculated with the current
Octave Tuning Style, and will change if you change the OTS. This feature helps
determine which CyberEar tuning mode to select later.

After each note is sampled three times, Good, Fair, or Poor will appear under
the note, indicating the variance (consistency) of the note’s three samples. Good
variance means the three samples were very similar and yields the most accu-
rate tunings. Fair variance is acceptable for one or two notes. But if any note
reads Poor, you should redo (resample) it. To redo a sample, tap on its key or
variance box. An ear icon will appear over the note, meaning it's OK to play the
note again. To cancel a resample, tap the Stop button.

The piano doesn’t need be in tune or at correct pitch when you sample. However,
it does need to be within 50¢. If the pitch produced by playing the key A4 is more
than 50¢ flat, Chameleon 3 will not respond right away. Eventually (after

about 30 seconds) Chameleon will display a dialog box suggesting the

piano may be very flat or sharp. To learn how to sample and tune a piano that’s
way off pitch, please read the Pitch Raising section later in this manual. Here are
some tips to improve variance: play a short-sustaining note twice during sampling
(especially A5, A6, and A1), play the note louder or softer (but never super loud)
reduce extraneous noises, move the device a few inches or rotate it slightly, point
the microphone directly at the soundboard, choose a cleaner-sounding string, or
pluck the string.

Tapping on Ch3’s green Left and Right arrow buttons are another way to select
an A note for resampling. After a note is resampled using this procedure, other A
notes will be auto-selected for resampling (sequentially A4, A3, A2, A1, A5, A6).
If you don’t want to sample other A notes, tap an arrow button repeatedly until no
notes are selected.

When resampling a note, the previous sample will be replaced (overwritten) by
the new sample only when all three samples are recorded. In other words, during
any note’s resampling, you can abort the resample and restore the previous
sample by using the Left/Right buttons to deselect that note or by tapping Stop.

The Stop button aborts the current recording process and restores samples from
the previous sampling session.

The Pause button lets you temporarily stop recording if, for example, you want to
explain to the customer how cool Pocket RCT is. Tap Pause again to continue.

Once recording is complete, tap the Calculate button. If Ch3 is set to Easy mode,
CyberEar will open and you're ready to tune strings.

We recommend you don’t name and save tuning records until you’ve used
Pocket RCT for a while (tuned about 20 pianos) and become more familiar with
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its operation. To learn how to name and save tuning records, please read the
section “Advanced Options” later in the manual.

Tuning strings in CyberEar

CyberEar helps you tune the strings to the 88 in-tune pitches that Chameleon 3
calculated.

Notes are identified by note name (e.g., A, A#, B, C, C#, etc.) and octave number
(0 to 8). Octave numbers change between B and C. Only sharp designations are
used (not flats). The lowest notes on a piano are A0, A#0, BO, C1, C#1, etc. The
highest notes on a piano are A7, A#7, B7, and C8. Middle C is C4.

When CyberEar opens, note AO and Fine Tune mode will be selected
(customizable in CyberEar's Prefs menu). For most notes, CyberEar listens to

a higher partial as displayed in the Partial Indicator box located lower left. (You
can view and customize these partial choices by tapping the Advanced button in
Chameleon 3, explained below.)

Why doesn't A4 show 0 cents in the Tune box? In fact A4 is always calculated
to be tuned to exactly 440 hertz or 0.00 cents at its first partial (fundamental).
CyberEar normally listens to A4 at its second partial, not the first, because the
second partial works best for tuning midrange notes (for aural tuners too). Due
to inharmonicity, the second partial is slightly higher than twice the frequency
of the first partial, so for most pianos the A4 Tune box will typically display a
cents reading between 1.5 and 2.5 cents at the second partial. This pitch for the
second partial is carefully calculated from each piano’s samples so that the first
partial (fundamental) of A4 will be tuned precisely to 0.00 cents or 440.00 hertz.
Because inharmonicity varies from one piano to another, especially different
manufacturers and models, their A4 readings will vary too.

Spinner

CyberEar’s Spinner looks like a round pie with two opposite slices removed.

The Spinner shows you if the selected note is sharp, flat, or in tune. The

Spinner rotates clockwise and moves to the right if the note is sharp. It rotates
counterclockwise and moves to the left if flat. The Spinner’s rotation and
movement increases or decreases proportionately to how far out of tune the note
is. When a note is close to being in tune, the Spinner will be centered on the
black Target and its rotation stopped.

When the note is extremely close to in tune, a faintly colored circle called the
Blush will appear inside the Spinner. The Blush starts at half the Spinner’s
diameter and gets larger as the note gets even closer, until the Blush completely
fills the Spinner when the note is essentially perfectly tuned. Generally, we
recommend getting at least partial or temporary blush on all strings when Fine
Tuning. The better the piano, the more discerning the client, and the more
skillful the tuner, the more likely you’ll see maximum Blush. But realistically it's
impossible (or impractical) to tune all strings on all pianos to a full Blush.

The first time you open CyberEar, the Spinner is set to rotate at setting 2.0 cents
per revolution per second. To adjust the Spinner rate, color, or arc size, tap the
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Spinner button. Students may prefer a less sensitive Spinner rate of 3.2 to 4.0.
In Pitch Raise mode, the Spinner is set to 4.0. (Many Pocket RCT users set the
Spinner rate to 2.0 for Pitch Raise mode.) Blush sensitivity will automatically
adjust to Spinner rate.

Note Switching

CyberEar’s NoteSwitcher “automagically” switches to the next chromatic note up
or down when you play it.

The best way to manually noteswitch chromatically is to tap left or right of the
Spinner’s oval. Tap at the far edge of the oval for octave up or down, and tap
just left or right of the Spinner for note up or down. The target areas for this
noteswitch are very large so you can easily use a finger. The target areas may
be highlighted and beep when you tap them. To control highlighting and beeping,
tap Pocket RCT's Prefs menu. (Beeping tends to slow down note switching.)

You can also manually switch notes or octaves by tapping CyberEar’s on-screen
navigation buttons or by using your device's big main button (up/down for note
switching, left/right for octave switching).

NoteSwitcher hints

If NoteSwitcher has trouble auto-switching to the next note up or down, play the
note it's stuck on, then re-play the note you want to switch to.

To switch to a note several half steps distant, play a chromatic run on the piano.
NoteSwitcher will follow along at about 3 notes per second.

You may lock or unlock the NoteSwitcher by tapping on the NoteSwitcher button
in CyberEar. When a lock symbol appears on the NoteSwitcher button, CyberEar
will only switch notes manually. This is useful for large pitch raises or noisy
situations.

You can set auto-noteswitching to bidirectional, up-only, or down-only in
CyberEar's Prefs menu. The NoteSwitcher button's telltale appearance changes
when up- or down-only is selected, the appropriate arrow on the button appears
or disappears.

Note order and muting procedure hints

Tuning chromatically from A0 up to C8 is considered by many experienced
tuners to be the most stable and efficient tuning method. Use two rubber mutes
(or a split mute, which is easy to make yourself using CA glue) and tune unisons
as you go. It's also OK to strip-mute the entire piano, tune a single string for

all notes, then tune unisons. If you use a strip mute, make sure the note hasn’t
drifted when you're tuning its unisons.

Always use your ears and your eyes. Listen to aural intervals during and, more

importantly, after tuning with any tuning device. By verifying that Pocket RCT did
its normal great job, you will also improve your aural skills. Pay special attention
to the bass/treble break on short-scale pianos (e.g., spinets, small grands, short
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consoles) where some notes may benefit from aural refinement.
Changing the pitch of a tuning or a single note

Chameleon 3 creates all its tunings in Equal Temperament at A-440. To tune

a piano to another pitch, in CyberEar tap the pitch popup menu (located top
center). Select a pitch in Hertz (441, 439, etc...) or cents from 440 Hz by
choosing Other, then entering a cents deviation by tapping the up/down arrows.

CyberEar’s Offset box can also be used to change pitch for a single note or any
number of notes. To enter an offset, tap in the Offset box. Up/down arrows and

a "c" (Clear) button will appear. Tap on a number place (hundreds, tens, ones,
tenths, hundredths) then tap the up/down arrows. Tap the Clear button to reset to
0.00. To close the up/down controls, tap outside the Offset box in a blank area.
The Offset box reading remains (even after note switching) until you change or
clear it. We recommend you use the Pitch Offset popup to alter the pitch of an
entire tuning and the Offset box to alter the pitch of a few notes. It's OK to use
the Pitch popup and Offset box simultaneously.

The Tune box also has up/down arrows that operate just like the Offset box’s, but
most users will rarely alter the Tune box reading.

After the piano is tuned

When you're finished tuning the piano in CyberEar, tap the OK button at the
top right corner of the CyberEar screen, or tap the Tools menu (lower left) then
select Chameleon 3. If you won't be tuning again soon you can simply push the
Off button of your Pocket PC device. Pressing the Off button when CyberEar is
active is not recommended on some machines since spinner loss may occur,
requiring soft reset.

CyberEar’s other buttons
Tap on the Spinner button to change Spinner rate, color, and arc size.

Tap on the Tune box Listener Ear then play the note to auto-measure a note’s
pitch. The auto-measured reading can be permanently saved by tapping the
Save Cents button. If you don’t tap the Save Cents button any change in the
Tune box will disappear when you change notes.

Tap on the Offset box Listener Ear then play the note to auto-measure how much
a note deviates from its in-tune pitch (as displayed in the Tune box.) A reading in
the Offset box remains until you clear it.

Tap on the NoteSwitcher button to lock/unlock auto-NoteSwitcher. Tap the Prefs
menu to select bidirectional, up-only or down-only.

Tap the Rotate View button to go from Portrait mode (vertical) to Landscape
mode, which displays CyberEar horizontally. (The Pocket PC holder allows you
to rotate your device to accommodate.) The Spinner and oval are larger in this
mode. Also, a graphic keyboard appears, helping you see the selected note (red)
and its listening partial (half red). Some functions are duplicated in Landscape,
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such as changing the Tune Box and Offset box readings, tap screen to change notes and octave,
NoteSwitcher lock/unlock, and Pitch. Those that are not are Tuning mode (Fine Tune, Pitch Raise,
Calibrate), Spinner button, Listener Ears for Tune and Offset boxes, and menu items; to access
these choices, you must return to Portrait mode. In Landscape mode only, you can change notes
by tapping a note on the graphic keyboard.

Selecting CyberEar’s Start mode and Start Note

You can choose whether CyberEar starts in Fine Tune, Smart Tune or Pitch Raise mode. You can
also choose which note CyberEar starts with. (These are called default settings.)

To make those choices, tap on the Prefs menu and check the desired Start mode and Start
note. In the Prefs window, you can also choose when to activate a default choice: after a tuning
is calculated an/or after you select a different tuning record using the File Open or New File
command.

Note: When you sample and calculate a tuning in Chameleon 3, CyberEar will always open to the
Start Mode and Start Note you selected in the Prefs window.

Pitch Raising

Pitch raising (or lowering) with Pocket RCT is very accurate and fast because every note is
automatically measured and overpulled using a customized overpull percentage optimized for
each note. The first pitch raise pass usually leaves most notes within a cent or two, even for pitch
raises of 50¢.

If the piano is off-pitch, you have two choices for changing the pitch, Smart Tune mode or Pitch
Raise mode. Generally you'd use Smart Tune mode if the piano is from 1 cent to 15 or 20 cents
flat (or sharp). Use Pitch Raise mode if the piano is farther out of tune. Many RCT users set Smart
Tune to the default start mode, and use it for almost all tunings.

Chameleon's Smart Pitch display shows the pitch of A1 through A5, helping you determine the
best pitch changing method for each piano.

What if the piano is very flat (or sharp)?

Of course, the piano doesn’t need be already in tune or even at 440 pitch when you sample.
However, it does need to be within about 50¢; if not, Chameleon 3 will not begin sampling.
Remember, Chameleon 3 has ears but not eyes, and can’t see what key you are playing; it can
only hear the pitch that’s produced. For instance, Chameleon 3 can't know whether you're playing
G#4 or a very flat A4. If Chameleon 3 doesn't hear an A4 pitch within 30 seconds of the Record
button tap, you'll see a dialog box suggesting that the piano may be very flat. If so, we suggest
you don't sample this piano but instead select a Demo piano: tap the Demo tab and select the
model most similar to what you're tuning: Kimball spinet, Everett console, Kawai UST 7, Yamaha
C3E 6' grand, Steinway D 9' grand. These Demo pianos are real pianos which were sampled by
us and whose samples are permanently stored in Ch3. Alternatively, you can use an already-
calculated saved tuning record (described below).

In addition to Chameleon's pitch display you can use CyberEar quickly check the overall pitch of
a piano you suspect is very flat or sharp. Choose a Demo piano most similar to the one you're
tuning, then calculate a tuning. In CyberEar using Fine Tune mode, play some notes (eg...., all
the A’'s or C's), watching the Spinner’s location on the oval to gauge the note’s pitch. The oval’s



10 crescents have cents labels beneath for this very purpose. If the piano is more
than 25 cents off, select Pitch Raise mode and Large pitch raise type, which will
increase the Spinner’s range to plus or minus 200 cents. This is a rough guide but
appropriately effective.

To pitch raise with Pocket RCT

Sample the piano in Ch3. Alternatively, if the piano is off pitch by more than, say,
20¢, don't sample but instead tap the Demo button and choose one of the five
Use the piano most similar to the piano you’re tuning then tap OK.

Occasionally, you might want to calculate a tuning from the piano you most

recently sampled after choosing a Demo piano. To do so, tap the Demo button
and select “Restore last recorded piano".

Changing pitch with Smart Tune and Pitch Raise mode

Calculate
After calculating a tuning or opening a saved tuning, go to CyberEar (you can tap

Tools menu>CyberEar). Tap the Tuning Mode popup menu (which may be set
retoe M {0 Fine Tune) and select Smart Tune or Pitch Raise. (If these modes are already

Fine Tune

selected, reselect.) The Smart Tune or Pitch Raise dialog box will open.

In the Pitch Raise dialog box, enter the piano's Lowest Plain Wire Note
(unwrapped string) by tapping the up/down arrows next to the Lowest Plain Wire
Note box, or use the large button just below the screen. The Lowest Plain Wire

Lowestobnwrerate [B2 B Note s identified by note name and octave number. B2 is the default as it is a
commonly used Lowest Plain Wire Note.

The Smart Tune dialog box asks for a bit more information:

* Highest Tenor Note is the note just below the first plate strut above the
temperament. This note has to be higher than the Lowest Tenor Trichord.

* Lowest Tenor Trichord - this lowest group of three strings must be the same or
higher than the Lowest Tenor Note.

* Tenor Bichord(s): Number of string pairs in the tenor (above Lowest Tenor Note).

* Lowest Tenor Note is the note just above the plat strut that separates the bass
and treble sections. The LTN has to be the same or lower than the Lowest Tenor
Trichord.

Usually, the other settings in the Pitch Raise dialog box don’t need to be changed.
But here’s an explanation anyway:
gcgr:;"iszg"f;ﬁw Pitch Raise type: choose Small (up to 60¢), Medium (60¢ to 100¢), or Large (over
(Oymedum (o 100g) 100¢) depending on how far your piano needs to be pitch raised.

Otase fover 10061 pitch Raise or Smart Tune mode is consistently are a little sharp, you can

o reduce the overpull percentages (not cents) by adjusting the overpulls by between
ool 2 -1% to -5% under Adjust Overpull %. Conversely, if your pitch changes are too
T‘S flat, adjust +1% to +5%. You can adjust overpull percentages at any time during

o a pitch raise as often as you wish. Check "Save as Default" to save your favorite
g setting.
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To help prevent string breakage in Pitch Raise mode, you can lower the Cents 11
Overpull Caps for Bass or Treble. This is a good idea if, for example, the strings are
rusty or you see evidence of previous string breakage such as splices or new wire. In
CyberEar the Overpull Cents box will appear in red if the Cents Overpulls are invoked.

To start a new pitch change, tap Start New. To continue a partially completed pitch
change, tap Resume. You'll return to CyberEar. If you're starting a new pitch change,
A0 will be selected. Play AO and let it sustain while the Spinner fills in. In other words,
don’t tune the string until the Spinner fills in completely. Then tune A0 so the Spinner
stops rotating.

Play the next chromatic note up. NoteSwitcher will auto-noteswitch and measure

it, calculate the correct amount of overpull and offset the Spinner’s black Target as
needed. The offset of the note being measured (how far out of tune) will be displayed
in the Original Cents box (area labelled as Orig:). If you want to rerecord any note
(because you accidentally struck the wrong note, the dog barked, etc...), select that
note, tap in the Original Cents box to erase the note’s measurement, and replay the
note. In Landscape mode, a blue Progress Bar appears over each note after it's been
measured and its overpull calculated. (Unlike RCT/laptop, tapping the Progress Bar
does not erase a note's measurement. To do so, tap the Orig Cents button as in
Portrait Mode.)

Continue tuning chromatically from AO up to C8 (or from bottom to top of tenor
section then bass section either direction), tuning each note’s unisons as you go. It
is not recommended to tune unisons after tuning all center strings or to use another
note order because the tuning will have noticeably less stability and will require more
overpull.

After pitch raising is completed, return to Ch3 by tapping the OK button (upper right)
or choose Ch3 in the Tools menu (lower left). Resample and create a new tuning
record. Return to CyberEar, select Fine Tune mode, and retune as needed.

Overpull amounts

Figure 1 shows the standard overpull percentages used by Pocket RCT when
calculating pitch raises. The overpull percentages jump from 12% to 32% at the break
between wound and plain-wire strings, which is why you enter the Lowest Plain Wire
Note into the Pitch Raise dialog box. In the example graph above, the lowest plain-
wire note is note 28, or C3, which of course will vary from piano to piano. Smart Tune
mode uses a similar but more dynamic overpull chart which is customized for each
piano depending on the user input in the Smart Tune dialog box.

| Reyburn CyberTuner Pitch Raise Overpull |
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Pitch Raise mode hints

When you first use Pocket RCT, the automatic NoteSwitcher is set to
bidirectional. You can change this to up only or down only under the Prefs menu.
Lock/unlock NoteSwitcher by tapping the NoteSwitcher icon in CyberEar. If pitch
raising a piano that’s substantially flat or if the piano’s tone is of poor quality,
NoteSwitcher might not function normally; if so, lock NoteSwitcher and manually
note switch.

Medium and Large Pitch Raise modes automatically set auto NoteSwitching to
up-only. (Down-only for Pitch Raise can be chosen in Prefs menu).

If the piano is more than 60¢ or 70¢ flat use Medium or Large Pitch Raise mode.
If NoteSwitching misbehaves, here's a hint: When you’re ready to switch up to
the next note, play a staccato blow on the note chromatically two notes above
the note you just tuned (and one note above the note you want to tune), then
immediately play the note you want to tune. This will engage auto NoteSwitcher
and (hopefully) not record the pitch of the note two notes up.

Don’t worry about getting a Blush when pitch raising, especially if the pitch raise
is over 50¢. (This takes practice.)

For pitch raises of 20¢ or less, it's worth using Smart Tune mode and tuning each
string and unison accurately. This is because Smart Tune's overpull calculations
are so smart most notes end up perfect in a single Smart Tune pass.

Chameleon 3’s Advanced Mode

Chameleon 3 starts off in Easy mode. This mode uses settings that work very
well on almost all pianos in almost all situations. If you want more choices, you
can use Advanced mode to select a different amount of overall stretch and
various tuning partials. Advanced mode also displays a sampled note’s variance
in cents (instead of Easy mode’s Good, Fair, and Poor)

Advanced mode gives you access to Pocket RCT’s file menu, letting you name
and save tunings, and manage your tuning record library.

Octave Tuning Styles

In Advanced mode you can choose from nine graduated levels of overall stretch
ranging from very clean (Octave Tuning Style 1) to very stretched (Octave Tuning
Style 9). OTS 4 uses a stretch style similar to what most pro tuners (using RCT,
or aural) prefer on most pianos, which is why OTS 4 is automatically selected

in Easy Mode. We suggest Advanced Users use Easy mode or OTS 4 on a few
pianos, listen then decide if you prefer more or less overall stretch. Chameleon

3 remembers the current set of A-note samples until you sample another

piano, even if you quit Pocket RCT or turn off your device. This means you can
calculate many tunings for a piano (e.g., with different OTS's or tuning partials)
without resampling.

Alower OTS, such as OTS 2 or 3, is sometimes preferred for low inharmonicity
pianos such as Kawai and Yamaha, especially consoles and smaller grands.

Higher-stretched styles such as OTS 6, 7, and 8 are sometimes preferred for
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B = Bass control octave (A2 to A3 6:3 octave)

T = Treble control octave (A3 to A4 4:2 octave)

A7 = high treble stretch (1.0 for pure single octave to 3.0 for pure triple)
SOM T = Treble control octave Single Octave Minimum (see below)
SOM B = Bass control octave Single Octave Minimum (see below)
DMax = Double Octave Maximum (see below)

large concert grands, most notably a Steinway D in a large concert hall. The tenth OTS is RPT
Exam, which emulates a Master Tuning for PTG’s Tuning Exam (OTS 4 with less high treble
stretch).

Octave Tuning Style beat rates are illustrated in Figure 2. For more detailed info, please see the
RCT Mac/Windows User Manual (available as a PDF at www.reyburn.com/download.html)

Predicted Beat Rates

When a tuning record is created, the predicted beat rates for B (A2-A3 as a 6:3), T (A3-A4 as

a 4:2), and D (double octave A2-A4 as a 4:1) are automatically written into the tuning record’s
header, visible in its tuning graph and in CyberEar. This allows you to “pre-listen” to the middle
octaves (and know if DMax and SOM were invoked, see below). A header can contain up to 70
characters. CyberEar’s header can display only half a header at time. Tap CyberEar’s header box
to view the other half.

Partials

Tap the Advanced button to view or select different partials for various sections of the keyboard.
The partials selected by Ch3’s Smart Partials feature sound great on almost all pianos. We
recommend you use the default partials (or Easy mode) on a few pianos then decide if you prefer
something different.

Tuning Graph
To display a graph of the 88 note’s target pitches, tap Advanced in Ch3 and select “Show graph



14

after Calculate.” Alternatively, select Graph in the Tools menu. When the graph is displayed, go to
CyberEar by tapping the CyberEar button or using the Tools menu to select CyberEar. This can
help you double check that the calculated tuning is OK. Look for smooth ascending graph lines.
To see what “normal” graphs look like, use the Demo piano button. To go from a tuning graph to
CyberEar, tap the CyberEar button or tap Tools then CyberEar or press the center of the device’s
4-way main button.

Automatic compensation for short-scale pianos

Easy mode and Advanced mode use some very smart guardians: Double Octave Maximum
(DMax) and two Single Octave Minimums (SOM Treble and SOM Bass). Together they’re called
the Limits and their job is to inspect and modify each calculated tuning so every piano will be
properly tuned regardless of size or scale design.

Let’'s assume you’ve sampled the A notes of your piano. During the fraction of a second after
tapping the Calculate button and before you see CyberEar (Easy mode) or a tuning graph
(Advanced mode), DMax and the two SOMs “pre-listen” to the tuning and, as necessary make an
interactive series of tuning compromises that closely mimic aural techniques.

Advanced mode tuning file and record management

It is important to understand the difference between a Tuning Record and a Tuning File. A Tuning
Record is used to tune one piano and is what you create when you tap the Calculate button in
Chameleon 3. Tuning Records are managed (named, deleted, moved, etc) within Pocket RCT
as described below. As many as 240 Tuning Records are contained inside a Tuning File. Tuning
Files are managed (deleted, renamed, etc.) using File Explorer.

You also should know how to use File Explorer, a very useful program that’s in all Pocket PC de-
vices (Start menu/Programs). File Explorer lets you see every file and folder on your device, edit
your device’s files and folders (not just for Pocket RCT), manually copy files to or from a memory
card, etc. If you need help learning to use File Explorer, please consult your Pocket PC documen-
tation, tap “Help” in the Start menu when File Explorer is active, contact your Pocket PC maker,
read a Pocket PC how-to book, or talk to a computer friend.

Name and Save Tuning Records

To be able to name and save Tuning Records, you must first tap the Advanced tab in Chame-
leon 3 then check Name and Save Tuning Records. Thereafter, when you sample a piano and
tap Calculate, the Piano Identity window will open displaying a two part header box and a serial
number entry box. In the first header box you can enter anything you’d like (e.g., name of piano
or customer) up to a limit of 35 characters. In the second header box the beat rates calculated by
Chameleon 3 (B=A2-A3 as a 6:3, T=A3-A4 as a 4:2, D=A2-A4 as a 4:1) will be automatically en-
tered. You can enter info into the 2nd header box but you’d have to overwrite the beat rates and
therefore this is NOT recommended.

Serial Number

In the serial number box you can enter the piano’s serial number or any other numeric data de-
sired. The serial number field accepts up to 8 digits (00000001 to 99999999), numbers only (not
letters).
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Open and View Tuning Files >

To select and open a Tuning File, tap the File menu and select Open File. The Open window

will be displayed. The Folder popup menu determines which Pocket RCT folders (located in My
Documents) will be displayed. Normally “All Folders” is selected. You may create your own folders
within My Documents using File Explorer, which will be displayed in the Folder popup menu (see
below). The Type popup menu lists which types of Pocket RCT files can be viewed (files ending in
.rctx and .exam are supported in version 1.6 and later, although the file extension won’t be visible
on a Pocket PC). To open a file, tap its name. Files can be sorted by Name, Folder, or Date by tap-
ping the column name, ascending or descending by tapping on up/down arrow. Some devices will
let Pocket RCT display RCT tuning files in pRCT’s Open File window even if the files are located
on a CF or SD card.

Open and View Tuning Records

To view the Tuning Records contained within a Tuning File, open the Tuning File (see preceding
description) or tap the File menu and select View Tunings (which will display Records of the cur-
rent File). Tuning Records will be displayed by tuning number (T#). The fields Piano/Customer and
Serial will display the data you entered in the record’s header (see File Naming/Saving above).

To change the width of a column, tap and hold to drag the column separator at the top. To open a
Tuning Record, tap its Tuning Number or the Spinner icon next to the Tuning Number. The current-
ly selected Record (open in CyberEar) will have a highlighted Spinner icon.

Edit Headers/Rename Records

To rename a Tuning Record (edit its header), go to View Tunings, tap and hold on the Record’s
header then select Rename, or select the Record’s header (tap once) then select Rename in the
Edit menu.

Move/Delete Tuning Records

To move or delete a Tuning Record, go to View Tunings. Tap and hold on a Tuning Record
header and select cut, copy, or delete. To paste a Record into another location in the same file,
tap and hold on another Record’s header and select Paste, which will paste the Record into the
location before that Record (not replace it). You can also cut, copy, paste or delete a Record by
selecting it (tap once) and using the Edit menu. Use File Explorer on your Pocket PC to delete or
rename Tuning Files.

Pocket RCT uses “Pocket RCT Library” as a default tuning file. This file is located in the Pocket
PCs "My Documents" folder. If this file is missing, moved, or renamed Pocket RCT will re-create
this file automatically and notify you.

Creating New Tuning Files
To create a new Tuning File, select New under the File menu. Name the Tuning File. To change
the name of a Tuning File, use File Explorer. Tuning Files are stored in My Documents folder.

Tuning Record Number in CyberEar
In CyberEar, the tuning record number is displayed above the left end of the header box.

Save Cents Button

The Save Cents button appears (in CyberEar in Fine Tune mode) when you tap the Tune Box’s
Listener Ear button or the Tune box. When you press Save Cents the reading in the Tune box is
saved to the tuning record and CyberEar switches up to the next note.
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The Save Cents button is handy for saving small adjustments to a tuning or for recording a com-
plete aural tuning. Tune a note until your ear is happy, tap the Left Listener ear button to auto-mea-
sure the note, then tap the Save Cents button. With practice, you can accurately record a complete
tuning in about 12 minutes.

When you have a really small adjustment on a single note or two, use the arrow buttons next to
the Tune Box to adjust the cents reading .3 to .5 cents, tune to get a blush, then re-listen (with your
ears!). Repeat as needed. When you like the change, tap Save Cents. Tapping on the cents read-
ing enables cents adjustment using the large button below the screen; left-right to change place,
up-down to change the cents reading.

PTG Tuning Exam Scoring

Start Exam scoring by choosing File menu, then Open file. Change the file type to Exam and

open the file. The Tools menu will have a Score function whenever an Exam file is open. Specific
instructions for running the exam are beyond the scope of this manual, see other RCT documenta-
tion on the reyburn.com download page for details.

Historical Temperaments

Tuning Records are calculated in Equal Temperament. To create a Historical Temperament Tuning
Record , in File menu, View Tunings, tap and hold on the a Tuning Record’s header and select
Hist Temp or select an item (tap once on its header) and Hist Temp under the Tools menu. Select
the Historical Temperament and tap Create. The first 57 Historical Temperaments used in Pocket
RCT are taken from Owen Jorgenson’s book Tuning. "Type" helps you identify the different temper-
aments: W=Well, R=Regular Meantone, M=Modern Meantone, Q=Quasi Equal, P=Pythagorean.
Type numbers are Pocket RCT’s way to help you identify the various temperaments within a Type.
After Creating a Historical Temperament tuning record, its Type (eg., W12) will be automatically
written into the end of its header, replacing “Ch3”.

User Temperaments

Creating a tuning with User Temps uses exactly the same procedure as built-in Hist. Temp. First
calculate a tuning, then Tap and hold on the tuning you want to use as a source. The choose "User
Temp" in the popup menu.

There are three User Temperaments shipped with Pocket RCT. The "Tems Temperament is only
for testing( not a real temperament). Vallotti-Young is exactly the same temperament as in "Hist.
Temp" and can be used for comparison. The other is a Mim Colement Sr. very mild well-temerpa-
ment (within 2 cents of equal temperament).

You can add your own custom user temperaments as follows.

1. Start Pocket RCT and choose File menu, then "Open File"

2. In the "Type" popup menu choose "User temp Files (*.hist).

3. Tap on "User Temperaments".

4. Tap and hold on the User Temp to sleect. If you are starting with a fresh copy you might want to
taop on the 4th item from the top which is the first blank temperament.

5. Choose "Edit User Temp".

6. Enter the name of your temperament along with the type (more on that later), the year, and the
twelve cents offset as needed.

To enter the "Type" field, enter a decriptive letter such as "W" for Well Temperament, then a num-
ber from 1 to 999 to indicate the number of the temperament. Up to four letters or numbers can be
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entered here. This indicator will be placed in the header of each tuning you create with this user
temperament. There is a maxium of 240 User Temperaments.

There are ten temperaments in the file (three filled and 7 blank). To add more User Temp records,
tap and hold a blank one, the copy and paste. It is beyond the scope of RCT documentaion to
explain how to determine temperament cents offsets or which temperment to use.

Direct Interval Tuning (Manual Mode)

Rather than use a sampled and calculated tuning record, a few advanced RCT users prefer to
set their own interval widths by manually selecting partials and adjusting the Tune Box. This
technique is called Direct Interval tuning or Manual Mode and requires exceptional theoretical
knowledge and a propensity for experimentation. This method is more time consuming and not
generally recommended. Direct Interval techniques require Pocket RCT to be set to listen at first
partial and for the Tune box to be at 0.00 for all notes. To do so, open File menu>New. Name the
new file something like "Direct Interval". Tap New File, then tap Tools menu>Cyberear. You'll go to
CyberEar with partial 1 selected (except for lowest octave A0-G#1 set to partial 2) and 0.00 cents
in the Tune box. Subsequently, you can open the Direct Interval file and tap/open the (unnamed)
first tuning record or Tools menu/CyberEar.

Pianalyzer

Pianalyzer is a mini-spectrum analyzer that measures pitch, inharmonicity, sustain, and volume
for the first 16 partials of any note. Pianalyzer is useful for tone education (for example, educat-
ing customers to help sell voicing jobs) and string design research. To open Pianalyzer, tap the
Tools menu and select Pianalyzer. To use Pianalyzer, select a note, tap the Record button, and
play the selected note medium loud, sustaining the note while the ear pulses. After a short time
the measurement results will be displayed. Tap the first column's header to switch between partial
number (p) and note name (n). Tap the second column's header to switch between cents and
hertz. Tap the third column's header to switch between Inharmonicity constant (Ic)) and sustain in
seconds (sec). Tap the headers of the fourth column to adjust the volume bars or display volume
numerically (volume units are arbitrary and are not decibels). To set the first partial (fundamental)
to 0.00, tap the button "Fund=0". Tap the button "Cents to EQ Temp" to switch to/from "Cents to
Harmonic". Tap the Legend button to learn about volume bar display colors and shortcuts.

Transferring RCT tuning files between RCT for Laptop and Pocket RCT

Pocket RCT uses tuning files identical to RCT for Laptop v3.5.x or later (MacOS and Windows).
In other words, a tuning file created by RCT on Mac/Win or Pocket PC can be transferred and
read by RCT running on any platform. Pocket RCT needs no conversion or “import” for RCT Mac/
Win 3.5 and later tuning files with the “.rctx” or “.exam” extension. Syncronization software or
memory cards are the usual method for transferring files between platforms.

Thanks for reading this document. We love people who read this stuff.
The RCT Team (Dean, Marty and Nate Reyburn)
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Troubleshooting Section

Soft Resetting your Pocket PC - the cure-all - try this first!

If your Pocket PC is locked up, frozen or not responding, if Pocket RCT’s Spinner is not visible, or if
your Pocket PC just seems to act abnormally, pressing Soft Reset will almost always solve the prob-
lem. Soft Reset is similar to telling a larger computer to “Restart” except the Pocket PC restarts in
about 15 seconds! The Soft Reset button is usually a small recessed button pressed with the stylus.
For the location on your hardware see your Pocket PC’s documentation.

The “power” button on a Pocket PC doesn'’t really turn the machine off. It is only a sleep or hibernate
button. So if you have a problem with the Pocket PC, pressing this button usually won’t help.

Turn off all programs and processes other than Pocket RCT. Bluetooth, WiFi and GPS functions
especially interfere with RCT listening process. Failure to turn off other processes can cause the
CyberEar spinner to be slow, jumpy or lock up.

Solving Pocket RCT installation problems
Normally Pocket RCT installs automatically when you insert the memory card into your Pocket PC
device. If not, please try these steps:

1. Eject all CF or SD cards, Soft Reset and try again.

2. To check that your memory card is being recognized, insert your memory card and:
A. Press Start menu > Programs > File Explorer. (or Start menu > File Explorer)
B. Just below the name File Explorer at the top, tap on “My Documents” (or whatever is
displayed there in a popup menu).
C. Choose “My Device”.
D. Inside “My Device” should be the memory card. It may be called “Storage Card”,
“Storage Card2”, “CF Card”, “SD Card” or something similar.

If after following steps A to D above, you don’t see anything that looks like a memory card, you prob-
ably have a hardware memory card recognition problem. Often using a can of compressed air (from
office supply store) to clean the slot will solve dusty SD slots. If not proceed to step E below. If you
DO see some type of memory card, proceed to step H below.

E.If you are using a generic SD card for installation, try reformating it in a Windows or Mac
computer (do NOT reformat your SentinelKey!!!).

Note: Reformatting a memory card erases all information, you will have to reload that info
afer reformat.

F. See if a different memory card is recognized (steps A-D above). A generic card is a
blank memory card you can purchase at a store where digital cameras or computers

are sold. If the generic card is recognized and the SentinelKey memory card is not, then
the SentinelKey card may be bad (very rare) or a pin may be bent in the card slot.

If your Pocket PC recognizes your memory card but Pocket RCT will still not auto-install, try this:

G. Is there a folder named “2577” on the memory card? If not, that’s the problem. You
may need to download Pocket RCT from the internet. See “Downloading...” below.

Note: The "2577" folder must be in the root directory of the memory card. In other words,




when you open the card, you should see "2577", it should not be inside another folder. 19
H. If there is a “2577” folder, tap to open the folder. Does the folder “2577” contain
these essential isntaller files?

1. WM34PocketRCT (Pocket RCT installer for WM 3 and 4.x, a “.CAB” file)

2. WM56PocketRCT (Pocket RCT installer for WM 5 and later, a “.CAB” file)

3. AUTORUN (makes Pocket RCT autoinstall on card insertion)

4. vX.X.Xfx (exampe: v4.5.4f1, a text file containing version information)

Is the Pocket RCT version you’re trying to install the same or older version as the version already in-
stalled on your device? If so, then that is why Pocket RCT won'’t autoinstall. Pocket RCT's Autorun is
designed to autoinstall only versions that are newer than the version already installed. You can install
older versions (or reinstall the same version) by uninstalling and then reinstalling.

Using File Explorer, if the “2577” folder, or either of the files it should contain, “Pocket RCT” or “AU-
TORUN?” are missing, then Pocket RCT will not auto-install. If the “PocketRCT” file is anywhere on a
memory card, you can install Pocket RCT manually by tapping on that file (see below).

Cleaning SD card contacts and SD slot.

If the Pocket PC can’t recognize that an SD card is inserted, and you’ve tried soft resetting, try
cleaning the gold contacts on the SD card. Use a clean pencil eraser (be careful to rub only once or
twice!), then clean with a cotton swab and alcohol. The SD slot can be cleaned with a can of com-
pressed air, available at office supply stores.

Manually Installing Pocket RCT or the RCT Ten Styles Library
Occasionally auto install doesn't work and manual installation is necessary. Auto install and manual
install result in exactly the same installed software on the machine.

Tap Start Menu/Programs/File Explorer (or Start Menu/File Explorer). In the menu at upper left
corner (just below "File Explorer", may say "My Documents"), tap the menu and select My Device/
Storage (or CF or SD) Card/2577. Tap on "Autorun". Installation should occur. If a window appears
informing you that a previous version is already installed, tap OK.

If you purchased the RCT Ten Styles Library and you need to install it manually, follow the same pro-
cedure as above. If needed you can install the library by tapping either file "RCT Ten Styles...". One
file will work, the other won't. After install, start RCT, choose File menu, Open file.

After Pocket RCT installation, and after starting Pocket RCT, check the About window (menu at the
bottom of Pocket RCT) to confirm the new version was installed. Always install the latest version.

Downloading the latest Pocket RCT update from the Internet.

Use our web form at www.reyburn.com/update.html for the latest download instructions. Please
include your full name and Pocket RCT nine digit serial number (on your SentinelKey or in Pocket
RCT’s About window). We will email you with complete instructions for downloading and installing
the latest version. Your internet computer will need a CF or SD card reader. Download and install
with Macintosh or Windows.

Downloading updates from the internet is the preferred way. But if that doesn’t work for you, updates
are also available on SD memory card for a nominal cost. You can always find the latest Pocket RCT
release at: www.reyburn.com/download.html or subscribe to our lists at: www.reyburn.com/lists.

To see which Pocket RCT version you’re running, start Pocket RCT and tap the About menu.



20

Managing your Pocket PC’s battery power

1. Adjust your Pocket PC’s Backlight settings at: Start > Settings > System (tab) > Backlight (or
Brightness, in addition, on some machines tap “Battery Power”).

If you have a Hewlett-Packard iPAQ models 2000 or above, or any Compaq iPAQ, skip to step
number 2 below (don't uncheck anything). On these iPAQs only, Pocket RCT 1.6.6 or later is
able to dim and brighten the screen in CyberEar and Chameleon 2 as needed. You can set the
“Turn off backlight...” setting to as low as 10 seconds, or any setting you wish on these iPAQ
models.

For non-iPAQs, or HP iPAQ 1900 series, uncheck the checkbox after “On battery power... Turn
off (or dim) backlight if device is not used for...”. Note that the text may vary on some ma-

chines.

2. On some machines tap “Brightness”. Adjust the “On battery power” Brightness to about
20%-40% of maximum. Use the lowest setting you can manage since the screen brightness is
by far the largest user of battery power on a Pocket PC.

3. Tap the link to “Power” at the bottom of the screen. Check the checkbox next to “On Battery
Power... Turn off device if not used for...”

4. Set the popup menu to “2 minutes” if you are a fast tuner and are familiar with RCT, other-
wise “3 minutes”. IMPORTANT! This box will control if and when your Pocket PC sleeps while
tuning in CyberEar.

When tuning with CyberEar, auto or manual noteswitching counts as the device being “used”
for power (but not backlight or brightness which is why we uncheck this above). If you take
more or less than a couple minutes per note, change and power settings accordingly as in step
4 above.

Hint: Don’t leave an SD or CF card attached if you don’t need to, as memory cards draw bat-
tery power. SD cards draw some power, but less than CF cards. See your Pocket PCs docu-
mentation for more specific information about battery conservation.
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To run Pocket RCT you need an Activation Code. We will create your unique Activation Code by
scrambling (encoding) two unique numbers.

1. The serial number of your Pocket RCT SentinelKey memory card. It is a 9 digit number written on
your SentinelKey in red ink.

2. The serial number of your Pocket PC device (Dell Axim, HP iPAQ, etc... )

Always install the latest version, especially if this is your second Pocket PC device. Installing an
older RCT version on a newer machine may cause compatibility issue. Visit www.reyburn.com/
download.html to obtain the latest version. if your device uses Windows Mobile 5.0 or later you must
use the correct pRCT version. An upgrade fee may apply.

How to view the serial number of your Pocket PC device.

1. Turn on your device and insert the Pocket RCT SentinelKey into your Pocket PC device’s slot.
Pocket RCT will install automatically. In some rare instances, you may need to install manually. See
Manual Install Instructions in the Troubleshooting section earlier in this manual.

2. After installation is complete, tap the Start menu and select Pocket RCT. The Activation Window
will appear.

3. Tap on the little square button at the lower left labelled “s/n” (serial number). The input keyboard
disappears and you’ll see your device’s serial number. The s/n will have between 10 and 20 digits.
*Note- to ensure accuracy do NOT obtain the deivce s/n from any other source.

To obtain your Activation Code

1. On your Internet browser, go to www.reyburn.com/activate.html . Fill in the information on the
web form and submit the form to us. Please submit only accurate and complete information. Inaccu-
rate information or guesses will delay your Activation code untill the issues are resolved.

PLEASE don't email serial numbers to us... use the webform! We'll email you an Activation Code,
usually within one business day*.

2. After you receive your Activation Code, please follow the installation instructions earlier in this
manual, page 2.

Please, Please, PLEASE be very careful to submit BOTH serial numbers (SentinelKey and Pocket
PC device) EXACTLY as they appear. If you send us an incorrect or mistyped serial number your
Activation Code will not work. The letter O and numeral O are interchangeable. We copy and paste
the serial numbers you submit to avoid typing errors on our end.

*We strongly discourage voice phone activations. ANY phone activations have a 1-2 business day
delay. If you don’t have email, a friend might, or the local library will. If you absolutely cannot use the
internet, you may fax us or phone. This option is for North American, English speaking customers
only. Do not leave the serial numbers on voice mail. Clearly leave a phone number, your name, and
the best time to return your call. Please have both device and SentinelKey serial numbers before
contacting us.

Outside North America, you must use our internet web form, fax, or contact your distributor for your
Activation Code.
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Calibrating the pitch of your Pocket PC

After installing and activating Pocket RCT you should calibrate the pitch
of your Pocket PC. This insures that your Pocket PC’s sound hardware is
perfectly tuned to A440. Please read this entire sheet before beginning.

1. Turn on your Pocket PC. Tap the Start menu and tap Pocket RCT. Tap the
Tools menu (located lower left) and tap CyberEar. Inserting your SentinelKey at
this point is a good idea (but not required), that way pRCT will save the calibra-
tion for later use.

2. Tap the Tuning Mode popup menu (which now displays Fine Tune or
Pitch Raise). Tap Calibrate.

3. On the back of your CyberFork is a sticker that reads “CyberFork” and
a cents number. This number is your CyberFork’s offset. (This sticker was
placed there by us after we measured the pitch of your CyberFork against

CyberFork

a perfectly calibrated pitch source.) Your CyberFork’s offset indicates how

flat or sharp it is from A440.00. Enter this offset into the CyberFork win-
dow, located on the left (not the Calibrate box, located right). Here’s how:
In the CyberFork window, tap on a place column (one cent, tenths of a
cent, or hundredths of a cent), then tap the up or down arrows. Enter all
digits carefully and be sure to use the correct sign (minus means flat).

4. On a flat padded surface (e.g., a magazine) place your Pocket PC
device on its back with its screen facing up. Push up one notch on the side
switch of your CyberFork to the “A” tone (check the switch to make sure
it's not B flat). Holding the CyberFork in your hand face down (“CyberFork”
label side up) and parallel to the tabletop, gently press it against the
Pocket PC device so that the CyberFork’s top inch (speaker) overlaps the
top inch (microphone) of the Pocket PC device. In other words, the Pocket
PC and CyberFork are touching each other face-to-face, speaker to micro-
phone.

5. During the rest of this procedure, gently press the Pocket PC and
CyberFork towards each other and against the padded surface, keeping
them as still as possible. This minimizes the effects of air distortion, en-
abling the Pocket PC device to “hear” the CyberFork’s pitch with virtually
the same accuracy as a direct-line input. Accurate calibration is possible
only in a noise-free environment, so find a peaceful quiet moment for cali-
brating.
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6. Tap the Right Listener Ear button under the Calibrate box, located on the
right (not the CyberFork box, located left). The Spinner will automatically fill
in (indicating the CyberFork’s pitch is being measured) seven times. After
each fill-in, the Calibrate box will display the measured pitch offset of the
CyberFork. (If readings vary, the differences will probably be no more than
a few hundredths of a cent. Such small fluctuations are normal and accept-
able.) After the seventh reading, a cents reading will be displayed in the
Calibrate box. This final reading tells you how off pitch your Pocket PC’s
sound hardware is and tells Pocket RCT how much to calibrate itself so it’ll
be set to A440.00.

7. Verify the calibration. With the CyberFork’s A440 tone still sounding, the
Spinner should display a full (or almost full) Blush.

If necessary, adjust the Calibrate box reading to obtain maximum Blush, or
repeat step 6.

& 8. Tap the Tuning Mode popup menu. Select “Fine Tune” instead of “Cali-

brate”. A dialog box will appear asking if you want to Save, Don’t Save or
Cancel your new Calibration setting. Tap the Save button.

9. Verify the calibration again. In Fine Tune mode and with CyberEar set to
A4, tap the Tune box to display its control arrows then enter the CyberFork’s
offset (on its back sticker) into the Tune box. Slide the CyberFork switch to
A4. The Spinner should be stopped or almost stopped and you should see
some blush. If not, carefully reread and repeat this entire calibration proce-
dure.

That’s it! Your Pocket PC is now pitch-calibrated to A440 while using Pocket RCT. Its calibration will
not change (even if you install a Pocket RCT upgrade) or drift (under normal operating temperatures
and usage) and only needs to happen one time (unless certain hardware components are replaced
in your Pocket PC or you do a hard reset). Now you can use your CyberFork as a metronome

when you practice piano, drums, etc... and you’ll have perfect time as well as perfect pitch! How-
ever please be careful with your CyberFork and its calibration sticker, you may need it to calibrate
another device in the future. A replacement CyberFork is $35 USD + s/h.
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RCT Authorized Distributors and

support contacts
(Primary area | support language)

Support note: using our web forms at www.reyburn.com/
contact.html is the fastest method of obtaining support.
See email note below before emailing reyburn.com.

North America | English: (Primary toll-free support num-
bers are underlined). In North America, you should recieve
a return call from our 888 number below by the end of the

next business day. If not, please try our internet web forms.

Outside North America, please use the internet or contact
your local distributor for support.

Reyburn Piano Service, Inc.

Dean Reyburn, RPT, Martha Reyburn, Associate
2695 Indian Lakes Road

Cedar Springs, MI 49319 USA

Toll free in North America:

1-888-SOFT-440 (1-888-763-8440) USA or Canada
or (616) 696-1002

cell: (616) 340-7277

fax: (616) 696-8121

Our internet web forms are the fastest way to get answers:

Tech support: www.reyburn.com.support.html
Activations: www.reyburn.com/activate.html
Update info: www.reyburn.com/update.html

All the above forms are linked from our main page at
www.reyburn.com, press the "contact" button.

Schaff Piano Supply Company
451 Oakwood Road

Lake Zurich, IL, 60047 USA
1-800-747-4266

email: schaff@reyburn.com

Canada , France & Europe | French & English:

Marcel Lapointe, RPT

6769 Avenue Royale

L'ange-Gardien, QC CANADA GOA 2KO0
(418)-822-3550

fax: (418)-822-3895

email: marcel@reyburn.com

English

Japan | Japanese:

Piano Resource Center / www.piano-re.com
4-21-19, Morino, Machida-shi

Tokyo, 194-0022, Japan

phone: 042-720-3752

fax: 042-720-3753

email: prc@reyburn.com

Europe | English, German, Norwegian & Swedish:

Odd Aanstad, RPT

Boda Asen SE - 67195 KLASSBOL Sweden
phone (+46) 570 511 84 Fax: (+46) 570 511 94
email: odd@reyburn.com

B.&K. Baumgartel GmbH
www.pianoteile-baumgaertel.de

Zeitzer Str. 60 D-07552 Gera Germany
phone: +49 (0) 365 413087

or +49 (0) 365 4390162

fax: +49 (0) 365 4200135

email: baumgartel@reyburn.com

Europe | English, Dutch, German & French:

Jan R.C. Lensing

Lensing Piano Service / www.pianostemmer.nl
Lutmastraat 141-A

1073 GV AMSTERDAM The Netherlands
phone (+31) 20 4702 639 or (+31) 618 844 013
fax (+31) 20 4702 639

email: jan@reyburn.com

U.K. and Ireland | English:

Heckscher & Co. Ltd.,
http://www.heckscher.co.uk/
75 Bayham Street

London, UK, NW1 0AA
phone 020 7387 1735

fax: 020 7387 3043

email: heckscherreyburn.com

Please soft reset your device and try again
before contacting RCT support! Soft reset
directions are in your hardware reference
manual. To soft reset, use your stylus to
touch a recessed button on the bottom, back
or side of the Pocket PC.

Troubleshooting Section is on pages 18-19.



